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Important Notice

We have done the utmost to make certain that the data that appears on tax forms produced
by the Club Tax Printer software is correct as based on the data in your current Investment
Club Accounting files. Nevertheless, we do not warrant the accuracy or completeness of the
data on the printed tax forms. All responsibility for accuracy and completeness rests with
your investment club and with the person who handles the tax matters for your club.
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Important: Partnership Return Deadlines

The deadline for filing Federal IRS partnership tax returns and providing partners with Schedule K-
Is is March 15th. Many states have adjusted their partnership filing deadlines, as well, so check
with your state to ensure that you meet their filing date. If allowed, partnerships may apply for an
extension using the state’s appropriate form. Members of your club should not file their personal
returns until they have received the appropriate information from the club.

Using the Club State Tax Printer

This Club State Tax Printer program works by reading your Club Accounting data, performing
calculations, and generating your tax forms. The program does not alter data stored in the Club
Accounting software. To properly use this program, your accounting records must be up-to-date.
We recommend running the year-end wizard (if using Club Accounting 3) and the Club Federal
Tax Printer before preparing your state tax return.

System Requirements
Use of the Club State Tax Printer software requires:

For Club Accounting 3 For myICLUB.com

e Compatible Windows operating system (Windows o Current generation web browser (Internet
7/8/10). Explorer, Microsoft Edge, Google Chrome,

¢ 256 MB of RAM minimum. Mozilla Firefox, Apple Safari).

¢ 30 MB of free hard drive space. e Internet access.

e Adobe Acrobat 6.0 or higher, available free from e Adobe Acrobat 6.0 or higher, available free
www.adobe.com. from www.adobe.com.

¢ Club Accounting version 3.2 or higher. e Current myICLUB.com subscription.

e Current Club Accounting Maintenance contract.




Installing the Club State Tax Printer

There are different options for installing the Club Tax Printer, depending on whether you use Club
Accounting 3 or myICLUB.com:

1. If you have purchased the downloadable version of the Club Tax Printer for Club Ac-
counting 3 (CA3), download it from www.iclub.com/taxes/download/. Save the installer to
your computer desktop. Once the download is complete, double-click on the Club State Tax

Printer Setup icon and follow the prompts. Once the installation is complete, close and re-
open CA3.

You do not need to download the installer onto the same computer on which you
=\ run Club Accounting 3, but can download it onto any computer. Use a thumb or
@ flash drive to transfer the installer to the CA3 computer, and install the Tax
Printer. Try this approach if you have a slow Internet connection or have trouble
downloading the installer.

2. If you purchased the Club State Tax Printer for myICLUB.com, there is no installation
needed. Visit the Taxes tab of myICLUB.com and click the button to run the program.

Running and Registering the Club State Tax Printer

The Club State Tax Printer for Club Accounting 3 is not a separate program, but an add-on to the
accounting software program.

Select Taxes from the CA3 menu to run the tax module.

When starting the Club State Tax Printer for CA3 for the first time, you will see the registration
window. You must register your program over the Internet with your Tax Printer serial number
before it is usable. Your serial number is proof that you purchased a license to use this program and
is included with the Tax Printer order receipt sent to you via email.

If you have multiple clubs licensed in your CA3 software, you will select the club from a list pre-
sented when you start the program. If you would like to generate tax forms for several clubs, you
will need to purchase a Tax Printer serial number for each club from www.iclub.com/taxes/.

No registration is required for the Club State Tax Printer for myICLUB.com. Visit the Taxes tab
of myICLUB.com and click the button to generate, print, and download your tax returns.

Special Note for Clubs in AZ, CA, IN, MA, NY, NJ, and WI

Business partnerships in Arizona are required to e-File their returns beginning with the 2020 tax
year. However, investing partnerships filing AZ Form 165 are not subject to this regulation, and
may file a return on paper using the ICLUBcentral Club State Tax Printer.

Partnerships in California must now file their state returns electronically using the Club State
Tax Printer for myICLUB.com, and paper forms are no longer provided. Clubs in California using
Club Accounting 3 should contact our Support team for assistance in converting their data for use
in myICLUB.com.

All clubs in Indiana must file tax returns. However, not all clubs can use the ICLUBcentral State
Tax Printer software. Beginning with the 2020 tax year, an investment club partnership in Indiana
that has more than 24 partners (as determined by the number of federal K-1s generated) must by
law file electronically (e-File) and cannot use the ICLUBcentral State Club Tax Printer. We suggest
using the Club State Tax Printer to generate a paper form, and contact a local tax preparer who can
transcribe and transmit your return at a discount.




All clubs in Massachusetts must file tax returns. If your investment club partnership is in Mas-
sachusetts and meets any one of the following criteria, you must e-File your return using the Club
State Tax Printer for myICLUB.com (beginning with the 2020 tax year):

e Have 25 or more partners (as determined by number of Schedule K-1s at the federal
level or Schedule 3K-1s at the state level)

e Have more than $50,000 in gross income (interest, dividend, and other income).

e Have more than $100,000 in stock sale proceeds (gross sales proceeds, not taxable
capital gain).

Clubs in Massachusetts using Club Accounting 3 should contact our Support team for assistance in
converting their data for use in myICLUB.com.

All clubs in New Jersey must file tax returns. If your investment club partnership is in New Jersey
and has 10 or more members (as determined by the number of Schedule K-1s at the federal level),
then you must e-File your return using the Club State Tax Printer for myICLUB.com (beginning
with the 2020 tax year). Clubs in New Jersey using Club Accounting 3 should contact our Support
team for assistance in converting their data for use in myICLUB.com.

Partnerships in New York are required to e-File their returns, and thus paper forms are no longer
provided in the Club State Tax Printer. Clubs using myICLUB.com may e-File their return using
the Club State Tax Printer for myICLUB.com. Clubs in New York using Club Accounting 3
should contact our Support team for assistance in converting their data for use in myICLUB.com.

Partnerships in Wisconsin are required to e-File their returns, and thus paper forms are no longer
provided in the Club State Tax Printer. The Club State Tax Printer for myICLUB.com supports
e-Filing for Wisconsin as of the 2020 tax year, and will not generate paper forms for filing. Clubs
in Wisconsin using Club Accounting 3 should contact our Support team for assistance in converting
their data for use in myICLUB.com.

Preparing the Club Data
Note: Skip this step if you have finalized your returns using the Club Federal Tax Printer.

Before generating tax forms, make sure that your accounting data is properly prepared. We recom-
mend that you wait until you have all necessary data and have performed a reconciliation of all
partnership accounts before completing your taxes. Necessary data includes your year-end broker-
age and bank statements; all buys, sells, dividends, interest, and service charges through December
31; and Form 1099s issued by your financial institutions. It is likely that you will not have this
information until mid-February.

-'- We recommend that you view the “Closing the Books at Year-End” webinar video
0 available in the Learning section of ICLUB.com for complete year-end procedures.

Once you have all the necessary data and the club has conducted its annual audit, close out the books
for the year, including creating a year-end Valuation Statement and Allocating Income and Expenses
for the year.

Users of Club Accounting 3 may close the books by following the instructions in the year-end task
wizard available under Tools > Year-end Tasks.




About Draft and Final Forms

The Club State Tax Printer software is often distributed before final forms have been released by
states. When you initially install the program, it may display preliminary forms with a “DRAFT”
watermark. Draft forms may not be used to file a return with your state. They are provided so
that you may get a head-start on the preparation of forms, diagnose any technical problems, and
ensure that your tax printer and club accounting software are working properly.

The Club State Tax Printer for myICLUB.com is updated automatically whenever a new version
is available. Whenever you run the program from the Taxes tab, it is the most current release.

The Club State Tax Printer for CA3 has an automatic updater built into the program. Each time
you start the Club Tax Printer, it will check the Internet to see if any updates are available. Of
course, you must be connected to the Internet in order for the auto-updater to work. When an update
is available, the program will download and automatically install the new version.

To check the release schedule for state forms, please check the home of page of www.iclub.com
regularly through the tax season.

Auto-Updating the Program with Final Forms

When an update to the Club State Tax Printer for CA3 is available, the program will prompt you
to automatically download and install it. When final forms are released, they are delivered to your
computer via an auto-updater.

If updates are available, you will be alerted to how many are available and their size. Click Yes or
OK to agree, and a dialog box will appear. Click OK to continue.

When installing updates, you may find the progress bar does not fill all the way before the updater
gives the option to click OK. If that happens, don’t worry; as long as the OK button is clickable on
the updater, your copy has installed the update.

The Club State Tax Printer for myICLUB.com is updated automatically with final forms behind
the scenes, with no action required by users.

Entering Your Club Information

Once you have registered, you will see a screen listing the states which are included in the Club
State Tax Printer. Choose your state and click OK. On the following screens, you will be prompted
to enter information about your club needed to generate your club’s tax forms. The specific ques-
tions and input required vary by state.

We recommend that you view the “Preparing Club Taxes” webinar video available in the
Learning section of ICLUB.com for complete details on the tax preparation process.

Please refer to the help files within the program for information that is relevant to your specific
state’s tax return forms. If necessary, you may use the Club State Tax Printer to complete the
forms for more than one state for a single club. States that require a return if any member is a
resident (regardless of where the partnership is domiciled) include Georgia, Missouri, New Jersey,
New York, Oregon, Pennsylvania, and West Virginia. Tax laws change frequently, so confirm the
regulations with any states in which your partners reside.

Generating Your Tax Forms

You are now ready to print your state tax return. You should generate a complete return, and then,
if your state requires a schedule similar to the Federal Schedule K-1, copies of this schedule for




each member. Members of clubs using myICLUB.com can click the links in the Taxes tab to down-
load and/or print their returns.

Check the appropriate boxes to print the main tax return and any additional schedules (as appropriate
for your state).

Create PDF Files. Selecting Finish will generate forms in PDF format and launch Adobe Acrobat.
From Adobe Acrobat, you can save or print your forms.

Print Your Tax Forms. To print forms, click on the printer icon or select the File > Print menu
item after you have generated your club’s tax return.

Save Your Tax Forms. To save tax forms to your computer, click on the disk icon or go to the File
> Save menu item. The files will be saved in Adobe’s PDF format. You may read these at any time
using the Adobe Reader.

Additional Notes. A “Partner’s identifying number” for each member is required for the tax return
to be complete. If the message “No Tax ID Entered” shows up next to a member’s name, or that box
is empty, that member’s Social Security Number was not entered in the Club Accounting program.
You can edit each member’s profile to add the number and then regenerate the forms, or you can
add the numbers by hand to the paper forms. If you choose to write in the numbers on the printed
forms, note that the saved PDF forms will not include Social Security Numbers, so saving a hard
copy with the numbers is preferred.

Select Quit to exit the Tax Printer.

What to Send to Your State Tax Agency. The Club State Tax Printer software prints returns and
schedules required for filing your club’s tax return in a format acceptable to your state’s Tax De-
partment. Instructions for what to send and where to send your return can be found on the cover
sheet printed with the return.

What to Give to Your Members. If your state requires, give each member a copy of his/her state
equivalent to Federal Schedule K-1. This schedule will be used in filing their personal state tax
returns. Individuals who withdrew from the club during the year must also be provided with the
appropriate tax forms as well as their final Withdrawal Report.

What to Keep for Club Records. The club should keep a copy of the full state return, all attached
schedules, and any supporting statements and attachments as part of its permanent records. We
recommend keeping electronic PDF files in addition to paper copies.

e-Filing Your State Return

Once the tax preparation wizard has been completed, users of myICLUB.com may proceed to e-
File their returns if preparing forms for California, Massachusetts, New Jersey, New York, or Wis-
consin. Some states require that your state and IRS forms be submitted simultaneously.

ICLUBcentral is an Approved e-Filing Provider for all states for which it provides forms, and thus
cannot provide paper filing options for these states pursuant to state regulations.

To e-File, look for the button that will appear at the bottom of the Club Tax Printer screen on
myICLUB.com to allow access to the e-Filing application. Follow the prompts on the five pages
that appear to confirm data, and once satisfied that the return is complete, click the button to e-File.

A Submission ID number will be provided once your return is accepted, which may take 24 hours
or longer.




Common Problems and Release Notes

e The Club State Tax Printer for CA3 requires registration before the program can
be run. Registration is done over the Internet from the registration screen.

e If you find the program taking a long time to load and/or print your Adobe Acrobat
Reader and tax forms, your computer or printer may lack sufficient memory. Select
fewer forms to print, then repeat the process.

e Links to forms and instructions are found in the program’s help section.

e Ifyour return contains a watermark reading “DRAFT,” final forms are not yet avail-
able. DRAFT forms may not be submitted to your state.

e The 2020 Club State Tax Printer software uses Adobe Acrobat to generate your tax
forms. A free copy of Adobe Reader installs with the tax program, or can be down-
loaded from www.adobe.com.

Answers to Frequently Asked Questions

For more information about club tax filing, using the Club Tax Printer, and year-end accounting
tasks, we suggest that you first use our Frequently Asked Questions (FAQ) searchable database
available at www.iclub.com/fag/. The answers to the most common questions will likely be found
here.

For additional help, please refer to the following pages on the ICLUB.com web site:

e Club Tax Printer Product Info www.iclub.com/taxes/
e Frequently Asked Questions www.iclub.com/faq/
e Club Tax Principles www.iclub.com/support/general _tax_principles.asp
e Understanding Club Tax Season www.iclub.com/support/tax_season.asp
e Download Club Tax Printers www.iclub.com/taxes/download/
e Investment Club Learning Center www.iclub.com/clubs/iclub_hub.asp
e Free Club Webinars www.iclub.com/clubs/webinar_information.asp

Requesting Technical Support from ICLUBcentral:

Each year, your club’s members look to you to make sure their taxes are filed in time. And each
year, from December to March, ICLUBcentral’s call volumes triple. We bring in extra help, update
the FAQs, and give it our all to answer your questions. Your patience is appreciated. Here’s looking
forward to a successful tax season!

Technical Support is available on our web site at www.iclub.com/support/. You may ask specific
questions via our web form and review the Frequently Asked Questions section of the web site at
www.iclub.com/faq/ as well.

Answers to questions about Club Tax Printer installation are included with your
purchase of the software. Questions about club accounting principles, tax issues,
0 and the Club Accounting 3 software are covered by your Club Accounting Soft-
ware Maintenance Agreement or mylCLUB.com subscription. To receive full cov-
erage, you must renew your Agreement each year.

If you cannot solve your problem using the Frequently Asked Questions tool at
www.iclub.com/fag/, the most efficient way to contact ICLUBcentral Technical Support is to




use our web help system located at www.iclub.com/support/. Our experts will be able to retrieve
and reply to your question quickly and efficiently.

Use the guide to help our experts quickly answer your questions. Write down the precise wording
of any error message displayed when you have a problem, including the names of any files men-
tioned in the message. Be familiar with:

e The version of Windows or other operating system that you are using.
The version of your web browser.
The amount of memory (RAM) on your computer.
The make and model printer if you have a question regarding printing.
Any security, firewall, or antivirus software running on your computer (Kaspersky,
McAfee, Norton, etc.).
e Your Club Tax Printer serial number and purchase/installation date.

User License and Support Agreement (ULSA)

Use of this product is governed by terms of a User License and Support Agreement or ULSA pro-
vided in the program upon use and installation. This License and Support Agreement is a legal
contract between your investment club or you in your individual capacity, as the case may be, and
ICLUBcentral Inc. By clicking on “accept” when you install the software, you are agreeing to be
bound by the terms and conditions of this agreement, including without limitation the customer
support provisions set out in the agreement. If you do not agree to such terms and conditions, you
must promptly return the software to ICLUBcentral in order to receive a refund. For more infor-
mation, please write to ICLUBcentral at 570 Kirts Blvd., Suite 237; Troy, MI 48084.

About ICLUBcentral Inc.

ICLUBcentral Inc. is the global leader in the development of software tools for investment clubs.
We have been making club accounting and tax software since 1989, and our products are used by
more investment clubs than any other in the world. Besides Club Accounting 3 and myICLUB.com
(www.myiclub.com), ICLUBcentral also produces:

e Newsletters such as the market-beating Investor Advisory Service (www.investoradviso-
ryservice.com); and the SmallCap Informer (www.smallcapinformer.com);

¢ Online tools including a stock screener, MyStockProspector.com (www.mystockprospec-
tor.com); a complete suite of online tools, data, and community for investors, StockCen-
tral.com (www.stockcentral.com); and an advanced stock research tool, Equi-
tyResearchService.com (www.equityresearchservice.com).

For details and special offers for you and your investment club members, please visit
www.iclub.com.

A Special Note for Users of Club Accounting 3

As most users are aware, Club Accounting 3’s lifecycle is at its end. ICLUBcentral will not provide
support for CA3 users after 2021. As such, we recommend that investment clubs switch to our cloud-
based club accounting platform, myICLUB.com before it is too late.

Switching to myICLUB provides a number of advantages that will save you money and streamline
club management tasks. Some of the myICLUB.com features not available in Club Accounting 3
include:

e c-File your club’s IRS tax returns.




To get started, our trained support team can migrate your club data to myICLUB.com and apply
any remaining term on your existing Club Accounting 3 subscription towards your first year. Visit
www.myICLUB.com/switch/ for details, and move your club forward into the next generation of

e-File your club’s California, Massachusetts, New Jersey, New York, or Wisconsin
State return.

Determine best methods of paying out partial or full member withdrawals with our
Withdrawal Scenario Calculator.

See breakdowns of holdings by company size, industry, sector, and super sector with
Portfolio Diversification Reports.

Change treasurers easily just by adjusting permissions in your private club website,
with no data import/export required.

Protect your data with redundant, secure, and automatic cloud-based backups.
Monitor club holdings closely with Stock Watcher Reports.

Save significantly with no upfront software cost, discounts for multi-year subscrip-
tions, and no additional charge for co-treasurers.

Store documents in your private, secure file storage library.

Get deep portfolio intelligence from more than 40 reports and graphs.

Find integrated help on each page.

tools used by thousands of investment clubs.




